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DISCLAIMER 

Please note that all product, product specifications and data detailed in this brochure are subject to change 
without notice to improve reliability, function, design or otherwise. Morgan AM&T B.V. and its affiliates does 
not assume any responsibility for the correctness of this information nor for damages consequent to its use. 
Statements regarding the suitability of products for certain types of applications are based on knowledge of 
typical requirements that are often placed on Morgan products in generic applications 

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 3 

Veuillez noter que tous les produits, toutes les caractéristiques de produits et données figurant dans cette  
brochure sont sujets à changement sans préavis afin d’améliorer la fiabilité, la fonction,  le design ou autre. 
Morgan AM&T B.V. et ses filiales n’assument  aucune responsabilité quant à l’exactitude de ces informations 
ni pour les dommages  consécutifs à son utilisation. Toute affirmation concernant la convenance des produits 
pour  certains types d’applications reposent sur la connaissance d’exigences spécifiques  	qui sont souvent 
placées sur les produits Morgan dans les applications génériques
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Sécurité
Nota En travaillant sur des machines électriques 
tournantes, il est essentiel que les directives de sé-
curité de base soient observées, ex : s’assurer que 
l’équipement est parfaitement isolé avant de com-
mencer à travailler. 

Vérifier auprès du représentant de la santé et de la 
sécurité que l’on se conforme aux procédures de sé-
curité locales, avant de commencer des travaux.
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INTRODUCTION

The primary object of maintaining or reconditioning a commutator or slip ring (Collector) is to remove those 
irregularities which lead to impaired brush efficiency and reduced brush and collector life. Collectors should, 
in an ideal world, be smooth and true. A collector that is in bad condition should be either re-ground or 
turned. 

In general, collectors with a Total Indicated Runout (TIR) of 76µm (3 mil) or greater and on a commutator 
with a Maximum Bar-to-Bar Height (MBTB) of 7.6 µm (0.3 mil) or greater needs to be re-ground or turned: 

Regular use of a profiling device such as the MSPro14 will help to confirm whether there is a problem with 
the collector and this should be done at least every six months and if possible every 2 months. Trending this 
information will help better plan maintenance schedules. 
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An acceptable commutator Profile An unacceptable commutator profile 

An acceptable slip ring profile An unacceptable slip ring profile

Therefore congratulations on purchasing the MSPro14 – the new and improved Surface Profiler from Morgan 
Advanced Materials. The MSPro14 is used for: 
 Collector surface profiling and measures TIR, MBTB as well as collector diameter 
 The TIR for collectors is the difference between the minimum height and the maximum height. The TIR is 

also referred to as the ‘runout’ or 'out of roundness'. 
 The MBTB Height for commutators is the maximum height difference between two adjacent bars. The 

MSPro14 can also determine when there are high micas present on Commutators. High Micas occur 
when there appears to be no gap between two consecutive bars. High Micas will be indicated as a bar 
number in the edit recordings dialog window. 

 The MSPro14 takes recordings in what the industry knows as ‘shape’ mode. Shape mode takes readings 
as the sensor moves over the collector surface and using these values it is able to generate a shape of 
the collector. Shape mode records a large number of samples, thus enabling a profile to be recorded 
allowing wear patterns and irregularities to be inspected. 

INTRODUCTION
L’objet principal de l’entretien ou de la remise en état d’une bague collectrice (collecteur) est d’éliminer les 
irrégularités qui altèrent l’efficacité des balais et réduisent leur durée de vie, ainsi que celle du collecteur. 
Les collecteurs doivent, dans l’idéal, être lisses et ajustés. Un collecteur en mauvais état doit être, soit 
rectifié, soit tourné.

En général, les collecteurs dont le faux-rond total indiqué (Total Indicated Runout - TIR) est de 76µm (3 mil) 
ou plus et un collecteur dont la hauteur maximale barre à barre (Maximum Bar-to-Bar Height - MBTB) est 
de 7,6 µm (0,3 mil) ou plus, doivent être rectifiés ou tournés :

Une utilisation régulière d’un système de profilage comme le MSPro14 permettra de confirmer s’il y a un 
problème de collecteur ; cela doit être fait au moins tous les six mois et si possible tous les deux mois. 
Dégager une tendance de ces informations permettra de mieux planifier la maintenance.

Situation Faux-rond 
(TIR)

Variation 
barre à barre

Profondeur 
du dégage-

ment

NOUVEAU Inférieur à 38 
um (0.0015”)

Inférieur à 5 
um (0.0002”)

1,3 um 
(0.050”) ou 

plus

EN SERVICE Inférieur à 76 
um (0.003”)

Inférieur à 7,6 
um (0.0003”)

0.5 mm 
(0.020”) ou 

plus

BESOINS DE 
RÉPARA-

TION

Plus de 76 um 
(0.003”)

Plus de 7,6 um 
(0.0003”)

0,25 mm 
(0.010”) ou 

moins
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An acceptable commutator Profile An unacceptable commutator profile 

An acceptable slip ring profile An unacceptable slip ring profile

Therefore congratulations on purchasing the MSPro14 – the new and improved Surface Profiler from Morgan 
Advanced Materials. The MSPro14 is used for: 
 Collector surface profiling and measures TIR, MBTB as well as collector diameter 
 The TIR for collectors is the difference between the minimum height and the maximum height. The TIR is 

also referred to as the ‘runout’ or 'out of roundness'. 
 The MBTB Height for commutators is the maximum height difference between two adjacent bars. The 

MSPro14 can also determine when there are high micas present on Commutators. High Micas occur 
when there appears to be no gap between two consecutive bars. High Micas will be indicated as a bar 
number in the edit recordings dialog window. 

 The MSPro14 takes recordings in what the industry knows as ‘shape’ mode. Shape mode takes readings 
as the sensor moves over the collector surface and using these values it is able to generate a shape of 
the collector. Shape mode records a large number of samples, thus enabling a profile to be recorded 
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Profil d’un collecteur acceptable Profil d’un collecteur inacceptable

Profil d’une bague collectrice acceptable Profil d’une bague collectrice inacceptable

Donc félicitations pour l’achat du MSPro14 – le nouveau profileur de surface amélioré de Morgan Advanced 
Materials. Le MSPro14 est utilisé pour : 	

•	 profiler la surface des collecteurs et mesurer le TIR, MBTB ainsi que le diamètre des collecteurs 	

	

•	� Le TIR des collecteurs est la différence entre la hauteur minimum et la hauteur maximum. Le TIR est 
aussi ce que l’on appelle un « faux-rond » ou une « excentricité ». 	

	

•	� La hauteur du MBTB pour collecteurs est la différence de hauteur maximum entre deux barres adjacentes. 
Le MSPro14 peut aussi déterminer s’il y a une forte présence de micas sur les collecteurs. Une forte 
présence de micas se produit quand il n’y a pas d’espace entre deux barres consécutives. Elle sera 
indiquée par un numéro de mesure dans la boîte de dialogue d’édition des enregistrements. 	

	

•	� Le MSPro14 saisit les enregistrements dans ce que l’industrie appelle le mode « forme ». Le mode forme 
effectue des lectures au fur à mesure du déplacement du capteur à la surface du collecteur et, à l’aide 
de ces valeurs, il peut reproduire la forme du collecteur. Le mode forme enregistre un grand nombre 
d’échantillons, ainsi un profil peut être enregistré et les traces d’usure et les irrégularités être inspectées.
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 Peak height mode can be selected (in the DASPro14 software) and is where one value per bar is 
displayed – this being the peak height of multiple samples taken across the entire bar. 

 Collected data can be transferred to a PC where it can be analysed in detail using the DASPro14 
Windows based software supplied in the kit. 

The MSPro14 also offers:
 A solid easy to mount sensor that can be fitted to a vast range of holder sizes, and is rugged enough to

cope with extreme environments including vibration  
 Easy to use responsive industrial colour touch screen  
 Optimised sensor head that is not negatively affected by Helically Grooved Slip Rings  
 Zero setting light indicators for easy set up  
 Previous Morgan supplied profiler measurements (.mas files) can be stored and combined  
 Extra extensive memory for storing information and editable on the data acquisition box 
 Comes in a robust carrying case including all attachments 

On/off button (1) 
Sensor lead port (2) 
USB port (3) 
LED display showing 3 different colours: (4) 

Green = Device is on
Orange = Device is on and charging 
Red = Device is off and charging 

Standard Kit Items: 
Included in the MSPro14 package which is supplied in a robust lightweight case including: 
 Data Acquisition Unit (the measuring box) 
 USB stick containing this manual and latest PC software (DASPro14 - Data Analysis Software) 

Sensor
 Protective Sensor sleeve and sensor spacer set 
 USB cable 
 AC power adaptor 
 External Battery 
 G (or C)-Clamp 

Flashlight & pen

12 3 4 
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RECOMMENDATIONS

Read this manual prior to installing the software and using the device for the first time. All instructions 
included in the manual must be followed. 

Remove any loose dirt/debris from the collector surface prior to taking a profile and always ensure that the 
sensor head is clean before taking any readings as this could affect the results of the profile severely. Use a 
clean, lint free cloth for this, for example, spectacle lens cleaning cloths 

The sensor head is a highly accurate piece of equipment, and although constructed to withstand normal 
handling, it should be treated with care at all times. The sensor should always be stored in its supplied 
sleeve when not in use.

When recording a profile, the results will be more consistent when the sensor is mounted as radially as 
possible (ideally ±1°) and when rotated in the direction as indicated in the figure below. 

Under no circumstances should the sensor be clamped directly ñ  it should always be fitted in a holder or 
sleeve and the sleeve held in place with a clamp. 

It is recommended that the sensor is calibrated every 12 months ñ  this can either be done by sending your 
MSPro14 to your local Morgan Sales office or directly to Morgan Advanced Materials Netherlands. 

•  �Le mode hauteur de pic peut être sélectionné (dans le logiciel DASPro14), dans ce cas une valeur par 
lame est affichée – il s’agit de la hauteur de pic de toutes les valeures collectées sur la lame.

•  �Les données collectées peuvent être transférées vers un PC où elles seront analysées en détail sous 
Windows à l’aide du logiciel DASPro14 fourni avec le kit.

Le MSPro14 offre également :

•  �Un capteur solide et facile à monter qui peut être installé sur tout un éventail de supports de différentes 
tailles et qui est assez robuste pour faire face aux environnements extrêmes, y compris aux vibrations

•  �Écran tactile industriel, couleur, réactif et facile à utiliser

•  �Tête du capteur optimisée qui n’est pas affectée négativement par les bagues collectrices à rainure 
hélicoïdale

•  �Voyants de mise à zéro pour une configuration simple

•  �Les précédentes mesures du profileur fournies par Morgan (fichiers .mas) peuvent être stockées et 
combinées

•  �Mémoire extra-extensible pour stocker l’information et les données éditables dans l’unité d’acquisition de 
données.

Livré dans un coffret de transport avec toutes les pièces annexes
Bouton Marche/arrêt (1) 
Port principal du capteur (2) 
Port USB (3)
Écran LED affichant 3 couleurs différentes : (4)

•  Vert = Appareil en marche

•  Orange = Appareil en marche et en charge

•  Rouge = Appareil à l’arrêt et en charge

Éléments standard du kit :
Sont inclus dans l’emballage du MSPro14, lequel est livré dans un coffret de transport léger et robuste :
•  Unité d’acquisition de données (MSPro 14)
•  Clé USB contenant ce manuel et le dernier logiciel PC (DASPro14 - Logiciel d’analyse des données)
•  Capteur
•  Gaine protectrice de capteur et jeu d’entretoises
•  Câble USB
•  Adaptateur c.a.
•  Batterie externe
•  Collier de serrage
•  Lampe torche & stylo
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 Peak height mode can be selected (in the DASPro14 software) and is where one value per bar is 
displayed – this being the peak height of multiple samples taken across the entire bar. 

 Collected data can be transferred to a PC where it can be analysed in detail using the DASPro14 
Windows based software supplied in the kit. 

The MSPro14 also offers:
 A solid easy to mount sensor that can be fitted to a vast range of holder sizes, and is rugged enough to

cope with extreme environments including vibration  
 Easy to use responsive industrial colour touch screen  
 Optimised sensor head that is not negatively affected by Helically Grooved Slip Rings  
 Zero setting light indicators for easy set up  
 Previous Morgan supplied profiler measurements (.mas files) can be stored and combined  
 Extra extensive memory for storing information and editable on the data acquisition box 
 Comes in a robust carrying case including all attachments 

On/off button (1) 
Sensor lead port (2) 
USB port (3) 
LED display showing 3 different colours: (4) 

Green = Device is on
Orange = Device is on and charging 
Red = Device is off and charging 

Standard Kit Items: 
Included in the MSPro14 package which is supplied in a robust lightweight case including: 
 Data Acquisition Unit (the measuring box) 
 USB stick containing this manual and latest PC software (DASPro14 - Data Analysis Software) 

Sensor
 Protective Sensor sleeve and sensor spacer set 
 USB cable 
 AC power adaptor 
 External Battery 
 G (or C)-Clamp 

Flashlight & pen

12 3 4 
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RECOMMENDATIONS

Read this manual prior to installing the software and using the device for the first time. All instructions 
included in the manual must be followed. 

Remove any loose dirt/debris from the collector surface prior to taking a profile and always ensure that the 
sensor head is clean before taking any readings as this could affect the results of the profile severely. Use a 
clean, lint free cloth for this, for example, spectacle lens cleaning cloths 

The sensor head is a highly accurate piece of equipment, and although constructed to withstand normal 
handling, it should be treated with care at all times. The sensor should always be stored in its supplied 
sleeve when not in use.

When recording a profile, the results will be more consistent when the sensor is mounted as radially as 
possible (ideally ±1°) and when rotated in the direction as indicated in the figure below. 

Under no circumstances should the sensor be clamped directly ñ  it should always be fitted in a holder or 
sleeve and the sleeve held in place with a clamp. 

It is recommended that the sensor is calibrated every 12 months ñ  this can either be done by sending your 
MSPro14 to your local Morgan Sales office or directly to Morgan Advanced Materials Netherlands. 

Lisez ce manuel avant d’installer le logiciel et d’utiliser l’appareil pour la première fois. Toutes les 
instructions figurant dans ce manuel doivent être suivies.

Éliminez les saletés/débris non adhérents de la surface du collecteur avant de saisir un profil et assurez-
vous toujours que la tête du capteur est propre avant de réaliser des lectures car cela pourrait sévèrement 
affecter les résultats du profil. Utilisez un chiffon, propre, non-pelucheux, par exemple, un chiffon de 
nettoyage pour objectif

La tête du capteur est une pièce très précise et, bien qu’elle soit conçue pour résister à un maniement 
normal, elle doit être traitée avec soin en toutes circonstances. Le capteur doit toujours être rangé dans sa 
gaine quand il n’est pas utilisé.

Lors de l’enregistrement d’un profil, les résultats sont plus constants si le capteur est monté aussi 
radialement que possible (idéalement ±1°) et s’il pivote dans la direction indiquée dans la figure ci-dessous.

Dans aucune circonstance le capteur ne doit être directement monté – il doit être toujours fixé à un support 
ou dans une gaine et la gaine maintenue en place à l’aide d’un collier.

Il est recommandé de calibrer le capteur tous les 12 mois – cela peut être fait en envoyant votre MSPro14 
dans votre bureau de vente local Morgan ou bien directement à Morgan Advanced Materials Netherlands.

RECOMMANDATIONS
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FIRST TIME USE 

Minimum PC requirements:
 Operating system: Windows XP or higher 
 Minimal 100MB of free disk space 
 Minimum of 1GB RAM memory 
 One free USB 2.0 port  

Once connected to a PC using the USB-cable, the Measuring Box reports itself as new USB-device. The 
Measuring Box may be accessed using a Windows File Explorer standard program. This enables the user to: 

Access files stored in the Flash memory of the Measuring Box (note that each measurement results in 
one file) 
update the Measuring Box software

6
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Registration of software on 1st use
Insert the supplied USB Memory stick into the PC and open the file; double-click on the software link which 
looks like:

Follow the on-screen instructions; if there are any warnings displayed regarding the software installation 
which could depend on your PC configuration, then press ì Yesî , however, if in doubt always contact your IT 
administrator. 

Press ì I agreeî  to continue 

PREMIÈRE UTILISATION

Configuration PC minimale requise :

•  Système d’exploitation : Windows XP ou supérieur)

•  Espace disque minimum 100 Mo

•  Mémoire RAM minimum 1 Go

•  Un port USB 2.0 libre

Une fois connecté à un PC à l’aide d’un câble USB, la MSPro 14 se signale comme nouveau dispositif 
USB. On peut accéder à MSPro 14 à l’aide d’un programme standard Windows File Explorer. L’utilisateur 
peut ainsi :

•  �accéder aux fichiers dans la mémoire Flash de MSPro 14 (remarquez que chaque mesure résulte en un 
fichier)

•  mettre à jour le logiciel de MSPro 14
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Registration of software on 1st use
Insert the supplied USB Memory stick into the PC and open the file; double-click on the software link which 
looks like:

Follow the on-screen instructions; if there are any warnings displayed regarding the software installation 
which could depend on your PC configuration, then press ì Yesî , however, if in doubt always contact your IT 
administrator. 

Press ì I agreeî  to continue 

Enregistrement du logiciel lors de la 1ère utilisation

Insérez la clé USB fournie dans le PC, puis ouvrez le fichier ; double-cliquez sur le lien du logiciel qui 
ressemble à :

Suivez les instructions à l’écran ; si des avertissements s’affichent à propos de l’installation du logiciel 
qui pourrait dépendre de la configuration de votre PC, appuyez sur « Oui », toutefois, en cas de doute, 
contactez toujours votre administrateur IT.

Appuyez sur «  J’accepte » pour continuer
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Click Next 

The default file location is selected; however, change if you require and click ì Nextî  to continue
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Once details are correct, press ì Installî

Once installation is complete, press ì Nextî

Cliquez sur suivant

L’emplacement du fichier par défaut est sélectionné ; cependant, changez-le si nécessaire, puis 
cliquez sur « Suivant ».
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Once details are correct, press ì Installî

Once installation is complete, press ì Nextî

Une fois que les détails sont corrects, appuyez sur « Installer »

Une fois l’installation terminée, appuyez sur « Suivant »
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The DASPro14 software is now ready to be registered prior to first use and can be done as follows:  

Double-click the link shown below which should be on your PC desktop: 

This will then open the following screen: 

If a registration key is already known, enter it in the appropriate field, else click the link which opens a 
webpage: 
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http://www.morganelectricalmaterials.com/mspro14-registration-form 

Once the necessary fields have been completed the submit button should be pressed and this will 
automatically send an email to: MSPro14.register@morganplc.com so that a registration key can be sent 
back to the user.

Once the registration key is received enter it in the appropriate field and press ì OKî  and the software will 
open accordingly. 

Le logiciel DASPro14 peut être maintenant enregistré avant une première utilisation. Vous pouvez procéder 
ainsi : double-cliquez sur le lien ci-dessous qui devrait se trouver sur le bureau de votre PC :

Il ouvre alors l’écran suivant :

S’il existe déjà une clé d’enregistrement, saisissez-là dans le champ approprié, ou alors cliquez sur le lien 
qui ouvre la page web :
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http://www.morganelectricalmaterials.com/mspro14-registration-form 

Once the necessary fields have been completed the submit button should be pressed and this will 
automatically send an email to: MSPro14.register@morganplc.com so that a registration key can be sent 
back to the user.

Once the registration key is received enter it in the appropriate field and press ì OKî  and the software will 
open accordingly. 

http://www.morganelectricalmaterials.com/mspro14-registration-form

Une fois que les champs nécessaires ont été complétés, appuyez sur le bouton soumettre, un e-mail sera 
automatiquement envoyé à : MSPro14.register@morganplc.com et une clé d’enregistrement sera envoyée 
à l’utilisateur.

Une fois que la clé d’enregistrement est reçue, saisissez-la dans le champ approprié, puis appuyer sur « 
OK », le logiciel s’ouvre.
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Software update procedure
Software updating will not be done automatically. The procedure for doing this on both PC-software and 
MSPro14 Box is as follows: 
 The user will receive an attachment in an email sent to the address used for registering the PC software 

or is instructed to download it from a specific server. 
Measuring Box:

ñ  Connect the measuring box to the PC or Laptop. 
ñ  Copy the update file to a specific folder on the measuring box. 
ñ  Disconnect the box from the PC or Laptop. 
ñ  Restart the box to perform the update. 

 PC software 
ñ Follow on-screen instructions as in the initial installation  
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USING THE MSPRO14 MEASURING BOX

First, connect the sensor to the MSPro14 measuring box then turn the unit on; wait for it to start-up at which 
point you will see the following screen: 

Procédure de mise à jour du logiciel

La mise à jour du logiciel ne se fait pas automatiquement. La procédure pour y parvenir, à la fois au niveau 
du logiciel PC et de la boîte MSPro14, est la suivante :
•  �L’utilisateur reçoit une pièce jointe dans un e-mail envoyé à l’adresse utilisée pour enregistrer le logiciel 

du PC ou bien il reçoit des instructions pour la télécharger d’un serveur spécifique.
•  MSPro 14 :

–       Connectez MSPro 14 au PC ou à l’ordinateur portable.
–       Copiez le fichier de mise à jour dans un dossier spécifique de MSPro14.
–       Déconnectez MSPro14 du PC ou de l’ordinateur portable.
–       Redémarrez MSPro14 pour faire la mise à jour.

• Logiciel PC
–       Suivez les instructions à l’écran comme dans l’installation initiale
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USING THE MSPRO14 MEASURING BOX

First, connect the sensor to the MSPro14 measuring box then turn the unit on; wait for it to start-up at which 
point you will see the following screen: 

Tout d’abord, connectez le capteur à MSPro14, puis mettez l’unité en marche ; attendez qu’elle démarre, 
vous verrez alors l’écran suivant :

La barre d’état montre la progression du chargement. Une fois le chargement terminé, l’écran de 
bienvenue s’affiche.

UTILISATION DE MSPro14 MEASURING BOX
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Welcome Screen 

This screen shows both the MSPro14 product ID and box software version. 

The symbols on the top of the screen mean the following: 

The size of the memory will be at least 30 Mbyte. This should be enough to store at least 250
datasets. 

Sensor position

Units currently set on box ñ  either metric or imperial 

Battery life

Press ok to continue 

Help 
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Home Screen 

There are 4 options to use: 

Start Measurement

View Data 

Settings 

Help 

Écran de bienvenue

Cet écran montre à la fois l’ID du produit MSPro14 et la version du logiciel. Les symboles qui se trouvent 
en haut de l’écran ont les significations suivantes :

La taille de la mémoire est au moins de 30 Mo. Ce qui devrait suffire pour stocker au moins 
250 ensembles de données.

Position du capteur

Unités actuellement configurées dans MSPro14 – unités métriques ou impériales Durée de 
vie de la batterie

Appuyez sur OK pour continuer

Aide
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Home Screen 

There are 4 options to use: 

Start Measurement

View Data 

Settings 

Help 

Écran d’accueil

On peut choisir entre 4 options :

Commencer les mesures

Voir les données

Réglages

Aide



15

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 15

SETTINGS 

From this screen you can alter 6-off different settings: 

Date & Time 
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Units & Language 

There are 5 different languages to choose from: English, Dutch, French, German and Spanish

Alarms 

Alarms can be set depending on the tolerances you require 

RÉGLAGES

De cet écran, vous pouvez définir six réglages différents :

Date et heure
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SETTINGS 
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Units & Language 

There are 5 different languages to choose from: English, Dutch, French, German and Spanish

Alarms 

Alarms can be set depending on the tolerances you require 

Unités et Langue

Il est possible de choisir entre 5 langues différentes : anglais, néerlandais, français, allemand et 
espagnol

Alarmes

Les alarmes peuvent être réglées en fonction des tolérances requises
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Display 

Brightness can be automatic or user defined 

Power Management 
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Sensor Settings 

This will display when the sensor number is correct  

If the sensor number is not valid or entered then this is shown 

Affichage

Le niveau de brillance peut être automatique ou défini par l’utilisateur

Gestion de l’alimentation
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Sensor Settings 

This will display when the sensor number is correct  

If the sensor number is not valid or entered then this is shown 

Réglage des capteurs

Il s’affiche quand le nombre de capteurs est correct

Si le nombre de capteurs n’est pas valide ou pas saisi, le texte suivant s’affiche
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START MEASUREMENT 

Once you decide to take a measurement you must determine the type of collector on which the profile is 
being taken, i.e. Commutator or Slip-ring

Commutator 
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On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the number of bars is known (diameter can also be entered but is not as accurate on a commutator)
then this should be entered as it will mean that the recording will stop automatically rather than the user 
having to stop the recording manually. 

Enter the required information using the on-screen keypad. Note the highlighted ë 0í ; if there are any 
machines in your database this number will reflect that allowing you to choose the previously entered 
machines ñ thus saving re-entering information.

The next screen is used to determine whether you require TIR and MBTB alarms, and if so, the value at 
which it is triggered; note that the default is that which is set on the Alarms page previously described. 

COMMENCER LES MESURES

Quand vous décidez de prendre une mesure, vous devez déterminer le type de collecteur dont vous 
saisissez le profil, c.-à-d un collecteur ou une bague collectrice.

Collecteur
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On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the number of bars is known (diameter can also be entered but is not as accurate on a commutator)
then this should be entered as it will mean that the recording will stop automatically rather than the user 
having to stop the recording manually. 

Enter the required information using the on-screen keypad. Note the highlighted ë 0í ; if there are any 
machines in your database this number will reflect that allowing you to choose the previously entered 
machines ñ thus saving re-entering information.

The next screen is used to determine whether you require TIR and MBTB alarms, and if so, the value at 
which it is triggered; note that the default is that which is set on the Alarms page previously described. 

Cet écran doit être rempli avec autant d’informations que possible, car vous pouvez l’utiliser pour générer 
votre propre base de données machine pour votre entreprise ; en outre, pour qu’une machine soit 
enregistrée dans la base de données, les 3 champs du haut doivent être remplis :

•  Nom de la machine

•  Fabricant

•  Modèle

Par ailleurs, si le nombre de lames est connu (le diamètre peut aussi être saisi mais il n’est pas 
aussi précis sur un collecteur), alors il doit être saisi car cela veut dire que l’enregistrement s’arrêtera 
automatiquement, plutôt que par un arrêt manuel de l’utilisateur.

Entrez les informations requises à l’aide du clavier d’écran. Remarquez le « 0 » surligné ; si des machines 
sont déjà enregistrées dans votre base de données, ce numéro vous le signale et vous pouvez alors 
choisir les machines déjà entrées – ce qui évite de saisir à nouveau les informations.

Le prochain écran est utilisé pour déterminer s’il vous faut des alarmes TIR et MBTB, et si c’est le cas, 
la valeur à laquelle elles se déclenchent ; remarquez que le défaut est celui qui est configuré sur la page 
Alarmes déjà décrite.
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Setting the Sensor 
The sensor has been designed so that for the greatest measurement range the sensor head should be
positioned mid-way through its travel, i.e. 3mm (118mil) in real terms, out of a possible 6mm (236mil). The 
ideal displacement is 0.00mm (0mil) however anywhere between ±0.2mm (±8mil) can be used as a start 
point. In order to fit the sensor the following needs to done: 
 Loosen the clamp knob counter-clockwise so that the clamp is as flat as possible. 
 Fit the sensor into the chosen empty brush box or sleeve along with any required packing pieces (or 

custom made holder) but do not tighten fully at this stage. Care should be taken to ensure that the sensor 
is fitted as square as possible in the brush box and if a commutator is being profiled (ideally) in the centre 
of a bar not in the gap between bars. 

 The sensor must be located in the brush box so the display reads ±0.2mm or ±8 mil or less; this will be 
highlighted by the screen displaying either red, amber or green icons – with appropriate text 
accompanying the icon: 
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Réglage du capteur

Le capteur a été conçu de façon à ce que concernant la plage de mesures la plus grande, la tête du 
capteur soit positionnée à mi-chemin de son déplacement, c.-à-d 3 mm (118 mil) en termes réels, sur un 
potentiel de 6 mm (236 mil). Le déplacement idéal est de 0,0 mm (0 mil), toutefois, toute mesure comprise 
entre ±0,2 mm (± 8 mil) peut être utilisée comme point de départ. Pour fixer le capteur, ce qui suit doit être 
fait :

•  �Déserrez la molette du collier de serrage dans le sens inverse des aiguilles d’une montre de façon à ce 
qu’il soit aussi plat que possible.

•  �Fixez le capteur dans le porte balais ou avec les cales requises (ou le support sur mesure), mais ne 
serrez pas encore à fond pour le moment. On doit s’assurer que le capteur est centré autant que 
possible dans le porte balais et si un collecteur fait l’objet d’un profilage, qu’il le soit (idéalement) au 
centre d’une barre et non dans l’espace entre les lames.

•  �Le capteur doit se trouver dans le porte balais, de façon à ce que l’écran affiche ±0,2 mm ou moins ; 
cela est mis en évidence par l’écran qui affiche des icônes rouges, oranges ou vertes – avec le texte 
approprié qui accompagne les icônes :
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of a bar not in the gap between bars. 

 The sensor must be located in the brush box so the display reads ±0.2mm or ±8 mil or less; this will be 
highlighted by the screen displaying either red, amber or green icons – with appropriate text 
accompanying the icon: 
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 When the sensor head is in position (ideally the display will be green), tighten the clamp in the holder or 
sleeve fully so that there is no movement from the sensor. Only hand tighten the sensor and do not use 
any tools or other equipment (as over tightening may damage the clamp). 

 Mark the collector surface so that a reference start/stop point can be located 
 Next, the collector needs to be rotated in the direction in which the profile will be taken in order to stabilise 

the sensor; if a full rotation is not possible then the collector must be rocked back and forth slightly – note 
that for consistent results the last movement must be in the same direction as that in which the profile will 
be taken. Note that the ‘Operational’ and ‘Settled’ �ags (on bottom left hand side of the screen) will 
change to ‘OK’ once this has been carried out correctly.

 Check the display still reads ±0.2mm (±8mil) or less and if you are measuring a commutator also ensure 
that the sensor is still located approximately in the middle of the marked bar 

 It is possible to continue when the sensor has not been placed correctly, i.e. when the arrow is orange
however an additional warning appears advising you of the issue. 

24

Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

•  �Quand la tête du capteur est en position (dans l’idéal, l’écran est vert), serrez fort le collier dans le 
support ou la gaine, de façon à ce qu’il n’y ait plus de mouvements au niveau du capteur. Le capteur doit 
être serré à la main, n’utilisez pas d’outils ou un autre équipement (un serrage trop fort endommagerait le 
collier).

•  �Marquez la surface du collecteur de façon à localiser un point de référence départ/arrêt

•  �Ensuite, le collecteur doit être tourné dans la direction où le profil est saisi afin de stabiliser le capteur 
; si une rotation complète n’est pas possible, alors il faut légèrement le basculer d’avant en arrière – 
remarquez que pour des résultats cohérents le dernier mouvement doit être dans la même direction que 
celle où le profil est saisi. Remarquez que les fanions « Opérationnel » et « Réglé » (en bas à gauche de 
l’écran) passeront à « OK » une fois que cela aura été fait correctement.

•  �Vérifiez que l’écran affiche toujours ±0,2 mm (± 8mil) ou moins et si vous mesurez un collecteur assurez-
vous aussi que le capteur se trouve toujours approximativement au milieu de la lame marquée.

•  �Il est possible de continuer si le capteur n’a pas été placé correctement, c.-à-d quand la flèche est 
orange, toutefois un autre message apparaît vous avertissant du problème.
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 When the sensor head is in position (ideally the display will be green), tighten the clamp in the holder or 
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any tools or other equipment (as over tightening may damage the clamp). 

 Mark the collector surface so that a reference start/stop point can be located 
 Next, the collector needs to be rotated in the direction in which the profile will be taken in order to stabilise 

the sensor; if a full rotation is not possible then the collector must be rocked back and forth slightly – note 
that for consistent results the last movement must be in the same direction as that in which the profile will 
be taken. Note that the ‘Operational’ and ‘Settled’ �ags (on bottom left hand side of the screen) will 
change to ‘OK’ once this has been carried out correctly.

 Check the display still reads ±0.2mm (±8mil) or less and if you are measuring a commutator also ensure 
that the sensor is still located approximately in the middle of the marked bar 

 It is possible to continue when the sensor has not been placed correctly, i.e. when the arrow is orange
however an additional warning appears advising you of the issue. 
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Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

Terminer un enregistrement

Faire pivoter le collecteur et l’unité commence alors à enregistrer



25

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 25

When rotation is detected the  will change to ; the recording will stop automatically if 

the number of bars (or diameter) was entered, else  will have to be pressed. 

It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between text or a real-time linear graph. 
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On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Return to home screen without saving 

Re-take recording, therefore deleting existing one 

Quand la rotation est détectée le  passe à  ; l’enregistrement s’arrête 

automatiquement si le nombre de barres (ou le diamètre) a été saisi, autrement  il faut appuyer 
sur le

Il est possible de modifier la façon dont les lectures sont présentées en appuyant sur le bouton 

 ou   ; on alterne ainsi entre le texte ou le graphique linéaire en temps réel.
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When rotation is detected the  will change to ; the recording will stop automatically if 

the number of bars (or diameter) was entered, else  will have to be pressed. 

It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between text or a real-time linear graph. 
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On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Return to home screen without saving 

Re-take recording, therefore deleting existing one 

Quand l’enregistrement est terminé, la page de synthèse suivante s’affiche :

Les symboles qui se trouvent en bas de l’écran signifient ce qui suit :

Retour à l’écran d’accueil sans sauvegarde

Refaire un enregistrement et donc supprimer l’enregistrement 
existant
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View alarms/errors ñ if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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If the user wants to save the recording, the following screen is displayed: 

The default filename is in the format: year/month/day-hour/minute/second – hence it will be totally unique; 
this filename can be over-written and/or modified if desired. 

In order to add the machine details into the database, the  button must be pressed – provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Voir les alarmes/erreurs – si ce symbole est surligné en rouge 

Afficher le tracé radial

Sauvegarder l’enregistrement

S’il y a des erreurs/alarmes déclenchées, elles seront affichées comme suit :

Le bouton du tracé radial permet à l’utilisateur d’avoir une vue d’ensemble de la forme générale - et de zoomer 
en avant et en arrière.
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View alarms/errors ñ if this symbol is highlighted in red 

View radial plot

Save recording 
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The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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If the user wants to save the recording, the following screen is displayed: 

The default filename is in the format: year/month/day-hour/minute/second – hence it will be totally unique; 
this filename can be over-written and/or modified if desired. 

In order to add the machine details into the database, the  button must be pressed – provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Si l’utilisateur veut sauvegarder l’enregistrement, l’écran suivant s’affiche :

Afin d’ajouter les détails de la machine dans la base de données, il faut appuyer sur le bouton

– à condition que les informations de la machine ne soient pas déjà dans la base de données, à 
moins que l’utilisateur ne préfère mettre à jour les données existantes avec la ou les dernière(s) lecture(s).
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The information can be transferred into the database by pressing the  button. 

Once the user wants to save the recording, the  button must be pressed. This will then lead to 
the following options: 
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Same Machine returns the user to the sensor 
setup 

Different Machine returns the user to the Start 
Measurement screen 

Return to home screen 

L’information peut être transférée vers la base de données en appuyant sur le  bouton

Quand l’utilisateur veut sauvegarder l’enregistrement, il doit  appuyer sur le bouton. Il aura 
alors accès aux options suivantes :
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The information can be transferred into the database by pressing the  button. 

Once the user wants to save the recording, the  button must be pressed. This will then lead to 
the following options: 
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Same Machine returns the user to the sensor 
setup 

Different Machine returns the user to the Start 
Measurement screen 

Return to home screen 

La même machine renvoie l’utilisateur vers la configuration du capteur

Une machine différente renvoie l’utilisateur vers l’écran Commencer les mesures

Retour à l’écran d’accueil
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Slip-ring 

On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the diameter is known then this should be entered as it will mean that the recording will stop 
automatically rather than the user having to stop the recording manually. 
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The next screen is used to determine whether you require TIR and Low Point alarms, and if so, the value at 
which it is triggered; note that the default is that which is set in the Alarms page. 

Setting the Sensor 
Set the Sensor in the same way as that described for a Commutator. 

Slip-ring

Cet écran doit être rempli avec autant d’informations que possible, car vous pouvez l’utiliser pour générer 
votre propre base de données machine pour votre entreprise ; en outre, pour qu’une machine soit 
enregistrée dans la base de données, les 3 champs du haut doivent être remplis :

•  Nom de la machine

•  Fabricant

•  Modèle

Par ailleurs, si le diamètre est connu, alors il doit être saisi car cela veut dire que l’enregistrement s’arrêtera 
automatiquement, plutôt que l’utilisateur l’arrête lui-même manuellement.
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The next screen is used to determine whether you require TIR and Low Point alarms, and if so, the value at 
which it is triggered; note that the default is that which is set in the Alarms page. 

Setting the Sensor 
Set the Sensor in the same way as that described for a Commutator. 

Le prochain écran est utilisé pour déterminer s’il vous faut des alarmes TIR et déterminer les points de 
consigne , et si tel est le cas, la valeur à laquelle elles se déclenchent ; remarquez que le défaut est celui 
qui est configuré sur la page Alarmes.

Réglage du capteur
Réglez le capteur de la même façon que celle décrite pour un collecteur.
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Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

When rotation is detected the  will change to ; the recording will stop automatically if 

the diameter was entered, else  will have to be pressed. 
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It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between either text or a real-time graph. 

On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Terminer un enregistrement

Faire pivoter le collecteur et l’unité commence alors à enregistrer

Quand la rotation est détectée le  passe à  ; l’enregistrement s’arrête 

automatiquement si le diamètre a été saisi, autrement,  il faut appuyer sur le
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Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

When rotation is detected the  will change to ; the recording will stop automatically if 

the diameter was entered, else  will have to be pressed. 

34

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 34

It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between either text or a real-time graph. 

On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Il est possible de modifier la façon dont les lectures sont présentées en appuyant sur le bouton  

ou   ; on alterne ainsi entre le texte ou le graphique en temps réel.

Quand l’enregistrement est terminé, la page de synthèse suivante s’affiche :

Les symboles qui se trouvent en bas de l’écran signifient ce qui suit :



35

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 35

Return to home screen without saving 

Re-take recording 

View alarms/errors ñ  if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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The results can be saved in exactly the same way as that described in the Commutator section. 

In order to add the machine details into the database, the  button must be pressed ñ  provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Retour à l’écran d’accueil sans sauvegarder Refaire un enregistrement

Voir les alarmes/erreurs – si ce symbole est surligné en rouge 

Afficher le tracé radial

Sauvegarder l’enregistrement

S’il y a des erreurs/alarmes sont déclenchées, elles seront affichées comme suit :

Le bouton du tracé radial permet à l’utilisateur d’avoir une vue d’ensemble de la forme générale - et de zoomer en 
avant et en arrière.
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Return to home screen without saving 

Re-take recording 

View alarms/errors ñ  if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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The results can be saved in exactly the same way as that described in the Commutator section. 

In order to add the machine details into the database, the  button must be pressed ñ  provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Les résultats peuvent être sauvegardés exactement de la même façon que celle décrite dans la section 
Collecteur.

Afin d’ajouter les détails de la machine dans la base de données, il faut appuyer sur le bouton  
– à condition que les informations de la machine ne soient pas déjà dans la base de données, à moins que 
l’utilisateur ne préfère mettre à jour les données existantes avec la ou les dernière(s) lecture(s).
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The information can be transferred into the database by pressing the  button and saved as 
previously described.
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VIEW DATA 

When the user wants to view previously taken collector readings, the following screen will be displayed: 

Scrolling through the data sets can be achieved by using the arrows on the side of the screen. 

When the required data set is located, the  button should be pressed. This will then show the 
individual recordings taken for on each machine:

L’information peut être tansférée vers la base de données en appuyant sur le bouton  et 
sauvegardée comme décrit auparavant.



37

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 37

The information can be transferred into the database by pressing the  button and saved as 
previously described.
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VIEW DATA 

When the user wants to view previously taken collector readings, the following screen will be displayed: 

Scrolling through the data sets can be achieved by using the arrows on the side of the screen. 

When the required data set is located, the  button should be pressed. This will then show the 
individual recordings taken for on each machine:

VOIR LES DONNÉES

Quand l’utilisateur veut voir des lectures de collecteur précédemment saisies, l’écran suivant apparaît :

On peut parcourir les ensembles de données en se servant des flèches sur le côté de l’écran.

Une fois que l’ensemble de données est localisé,  il faut appuyer sur le bouton. Les 
enregistrements individuels de chaque machine sont alors affichés :
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Once the required recording is located the  button is again pressed to continue; this will then 
display the same screen as that displayed following the completion of the recording, i.e.: 

The different icons can be selected as previously described.
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Standby Screen

On the main menu, the  button gives the user the following options: 

Turns the screen off 

Turns the unit off 

Returns to home screen 

After pressing the ì Display Offî  button the screen will go blank/turn off; when the screen is then pressed 
again the following is shown: 

Une fois que l’enregistrement requis est localisé, on  appuie à nouveau sur le bouton pour 
continuer ; il s’affiche alors le même écran que celui à l’achèvement de l’enregistrement, c.-à-d :

les différentes icônes peuvent être sélectionnées comme décrit précédemment.
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Once the required recording is located the  button is again pressed to continue; this will then 
display the same screen as that displayed following the completion of the recording, i.e.: 

The different icons can be selected as previously described.
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Standby Screen

On the main menu, the  button gives the user the following options: 

Turns the screen off 

Turns the unit off 

Returns to home screen 

After pressing the ì Display Offî  button the screen will go blank/turn off; when the screen is then pressed 
again the following is shown: 

Écran de veille

Dans le menu principal, avec le   bouton, l’utilisateur dispose des options suivantes :

Éteindre l’écran Éteindre l’unité Revenir à l’écran d’accueil

En appuyant sur le bouton « Display Off » (éteindre l’écran) l’écran s’éteint ; quand on appuie de nouveau 
sur l’écran ce qui suit s’affiche :
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Pressing the screen again takes you back to the Home screen 

The Power Off button shows the following screen: 

Return to home screen without turning off 

Turns unit off 
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En appuyant de nouveau sur l’écran, on revient à l’écran d’accueil Le bouton Power Off (Arrêt) affiche 
l’écran suivant :

Retour à l’écran d’accueil sans éteindre Éteindre l’unité
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Pressing the screen again takes you back to the Home screen 

The Power Off button shows the following screen: 

Return to home screen without turning off 

Turns unit off 
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PC ANALYSIS SOFTWARE 

DASPro14 
To open the DASPro14 software double-click the link as shown below: 

GENERAL 

 The DASPro14 can be run on a PC or Laptop running Windows® XP or higher. 
 Multiple Measuring Boxes can be managed by a single PC or Laptop. 

Only one Measuring Box can be connected to the PC or Laptop at the same time. There will be no support for 
handling multiple Measuring Boxes simultaneously. 

 No licence is needed to run the DASPro14 software. 
 Capability to import measuring files from the old PC profiler software 
 Prepare a measurement on PC
 Download it to the measuring box

USER INTERFACE 

The main window contains the following areas: 
 (1) Selected Downloaded datasets 
 (2) Recordings list: Selected recordings from the downloaded datasets. 
 (3) View area: this area will be used to plot the recordings, show values, etc. and has multiple tabs: 

1

2 

3
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 Tab bar:
1. Info: The info tabshows information about the loaded measurement and allows the user to make changes: 

a) User details (eg. Company, Operator, etc) 
b) Alarm Settings: BTB, TIR, etc. 
c) Recording details (eg. Name, type, size, etc.)

2. Values: This tab will show a table containing the measured values in numeric form. The values can be
modified by the user. 

a) Ability to copy values to clipboard for pasting in another application (for example, Microsoft. Excel)

LOGICIEL D’ANALYSE PC

DASPro14

Pour ouvrir le logiciel DASPro14, double-cliquez sur le lien comme ci-dessous :

GÉNÉRALITÉ

• Le DASPro14 peut s’exécuter sur un PC ou ordinateur portable équipé de Windows® XP ou supérieur.
• De nombreux MSPro14 peuvent se gérer à partir d’un seul PC ou portable.
• �Un seul MSPro14 peut être connecté en même temps au PC ou au portable. Il n’y a aucune assistance 

pour gérer simultanément plusieurs MSPro14.
• Aucune licence n’est requise pour exécuter le logiciel DASPro14.
• Capacité à importer des fichiers de mesure de l’ancien logiciel de profilage du PC
• Préparation d’une mesure sur PC
• La télécharger dans le MSPro14

INTERFACE UTILISATEUR

La fenêtre principale contient les zones suivantes :

• (1) Ensembles de données sélectionnés et téléchargés

• (2) �Liste d’enregistrements : Enregistrements sélectionnés à partir des ensembles de données 
téléchargés.

• (3) �Zone d’affichage : cette zone sert à planifier les enregistrements, afficher les valeurs, etc., et présente 
de nombreux onglets :
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PC ANALYSIS SOFTWARE 

DASPro14 
To open the DASPro14 software double-click the link as shown below: 

GENERAL 

 The DASPro14 can be run on a PC or Laptop running Windows® XP or higher. 
 Multiple Measuring Boxes can be managed by a single PC or Laptop. 

Only one Measuring Box can be connected to the PC or Laptop at the same time. There will be no support for 
handling multiple Measuring Boxes simultaneously. 

 No licence is needed to run the DASPro14 software. 
 Capability to import measuring files from the old PC profiler software 
 Prepare a measurement on PC
 Download it to the measuring box

USER INTERFACE 

The main window contains the following areas: 
 (1) Selected Downloaded datasets 
 (2) Recordings list: Selected recordings from the downloaded datasets. 
 (3) View area: this area will be used to plot the recordings, show values, etc. and has multiple tabs: 
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 Tab bar:
1. Info: The info tabshows information about the loaded measurement and allows the user to make changes: 

a) User details (eg. Company, Operator, etc) 
b) Alarm Settings: BTB, TIR, etc. 
c) Recording details (eg. Name, type, size, etc.)

2. Values: This tab will show a table containing the measured values in numeric form. The values can be
modified by the user. 

a) Ability to copy values to clipboard for pasting in another application (for example, Microsoft. Excel)

• Barre à onglets :
1. �Info : L’onglet Info affiche des informations à propos de la mesure chargée, il permet à l’utilisateur 

de faire des modifications :

a) Détails à propos de l’utilisateur (ex : entreprise, opérateur, etc.)

b) Réglages d’alarme : BTB, TIR, etc.

c) Détails de l’enregistrement (ex : nom, type, taille, etc.)

2. �Valeurs : Cet onglet affiche un tableau contenant les valeurs mesurées sous forme numérique. 
L’utilisateur peut les modifier. 

a) Possibilité de copier les valeurs du presse-papier pour les copier dans une autre application (par 
exemple, Microsoft. Excel)
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3. Chart: The chart tab will show a linear plot of the selected recording(s). Available functions are: 

a) Pan & zoom
b) Rotate, flip & align plot
c) Adjust axis scale & colours
d) Show/hide horizontal and/or vertical gridlines 
e) Copy (copy chart plot + legend as a picture on the clipboard) 
f) Print (chart plot + headers) 

4. Radial: The radial tab will show a radial plot of the selected recording(s). Available functions are: 

a) Pan & zoom
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b) Rotate, flip & align plot
c) Adjust axes scale & colours 
d) Show/hide middle circle, limit circles and/or central gridlines
e) Copy radial plot + legend as a picture on the clipboard 
f) Print (radial plot + headers)

Menu bar 
1. File: file related functions like: open, save, close, etc. 
2. Box
3. Tools
4. Help 

 Button bar: The button bar will show the most commonly used functions as buttons. Depending on the 
selected tab, other buttons will be available. 

 Status bar: shows status information and is  used for showing status information, for example: 
1. Detected Measuring Box 
2. PC/Measuring Box software update available (future option) 

USING DASPRO14 FOR THE FIRST TIME 

On first use the import folder in which the datasets will be downloaded to needs to be set; the following 
screen will be displayed: (Note that this can be changed at any time by selecting “Tools>Settings”

The units and language can also be set in this screen

USING DASPRO14 

Adding Datasets 

There are 2 ways in which recordings can be added to the import folder: 
 As in normal file handling and dragging and dropping the associated files directly from the MSPro14 unit 

3. �Tableau : L’onglet tableau montre un tracé linéaire du ou des enregistrement(s) sélectionné(s). Voici les 
fonctions disponibles :

a) Panoramique et zoom
b) Pivoter, inverser et aligner le tracé
c) Ajuster l’échelle de l’axe et les couleurs
d) Afficher/cacher le quadrillage horizontal et/ou vertical
e) Copier (copie graphique + légende comme image dans le presse-papier)
f) Imprimer (graphique + entêtes)

4. �Radial : L’onglet radial montre un tracé radial du ou des enregistrement(s) sélectionné(s). Voici les 
fonctions disponibles :

a)  Panoramique et zoom
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3. Chart: The chart tab will show a linear plot of the selected recording(s). Available functions are: 

a) Pan & zoom
b) Rotate, flip & align plot
c) Adjust axis scale & colours
d) Show/hide horizontal and/or vertical gridlines 
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b) Rotate, flip & align plot
c) Adjust axes scale & colours 
d) Show/hide middle circle, limit circles and/or central gridlines
e) Copy radial plot + legend as a picture on the clipboard 
f) Print (radial plot + headers)

Menu bar 
1. File: file related functions like: open, save, close, etc. 
2. Box
3. Tools
4. Help 

 Button bar: The button bar will show the most commonly used functions as buttons. Depending on the 
selected tab, other buttons will be available. 

 Status bar: shows status information and is  used for showing status information, for example: 
1. Detected Measuring Box 
2. PC/Measuring Box software update available (future option) 

USING DASPRO14 FOR THE FIRST TIME 

On first use the import folder in which the datasets will be downloaded to needs to be set; the following 
screen will be displayed: (Note that this can be changed at any time by selecting “Tools>Settings”

The units and language can also be set in this screen

USING DASPRO14 

Adding Datasets 

There are 2 ways in which recordings can be added to the import folder: 
 As in normal file handling and dragging and dropping the associated files directly from the MSPro14 unit 

b) Pivoter, inverser et aligner le tracé

c) Ajuster l’échelle des axes et les couleurs

d) Afficher/cacher le cercle du milieu, les cercles de limite et/ou le quadrillage central

e) Copier le tracé radial + la légende comme image dans le presse-papier

f) Imprimer (tracé radial + entêtes)

•    Barre de menu
1. Fichier : fonctions liées aux fichiers, comme : ouvrir, sauvegarder, fermer, etc.
2. MSPro14
3. Outils
4. Aide

• �Barre de boutons : La barre de boutons montre les fonctions les plus courantes des boutons. En fonction 
de l’onglet sélectionné, d’autres boutons sont disponibles.

• �Barre d’état : montre le statut, on l’utilise pour informer sur le statut, par exemple :
1. MSPro14 détecté
2. Mise à jour disponible du logiciel de mesure du MSPRo14 /du PC (future option)

UTILISATION DE DASPRO14 POUR LA PREMIÈRE FOIS

Lors de la première utilisation, le dossier d’importation dans lequel les ensembles de données sont télé-
chargés doit être établi ; l’écran suivant s’affiche : (Remarque : cela peut être modifié à volonté en sélection-
nant « Outils>Paramètres »

Les unités et la langue peuvent aussi être définies sur cet écran

UTILISATION DE DASPRO14

Ajout d’ensembles de données

Il y a 2 façons d’ajouter des enregistrements au dossier d’importation :

• �Comme pour le maniement d’un fichier normal, vous pouvez glisser et déposer les fichiers associés directe-
ment de l’unité MSPro14
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By selecting “Download from Measurement Box” and following the on -screen instructions

Once there are datasets on the PC, they can be added by pressing the  button; the dataset will then be 
displayed in the dedicated area. Clicking on the dataset displays the individual recordings: 

Double-clicking on the individual recording will add it to the recordings list where it can be viewed in detail by 
selecting one of the 4 different tabs 
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Printing 

To print a report on the data, click File>Print Report and select what needs to be printed from the 
available options and follow on-screen instructions

•        En sélectionnant « Télécharger MSPro14 » et en suivant les instructions à l’écran.

Une fois que les ensembles de données sont dans le PC, on peut les ajouter en appuyant sur le  
bouton ; l’ensemble de données s’affiche alors dans la zone dédiée. En cliquant sur l’ensemble de 
données, les enregistrements individuels sont affichés :

En double-cliquant sur un enregistrement individuel, on l’ajoute à la liste des enregistrements où il peut être 
visualisé en détail en sélectionnant l’un des 4 onglets.
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By selecting “Download from Measurement Box” and following the on -screen instructions

Once there are datasets on the PC, they can be added by pressing the  button; the dataset will then be 
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Printing 

To print a report on the data, click File>Print Report and select what needs to be printed from the 
available options and follow on-screen instructions

Impression
Pour imprimer un rapport sur les données, cliquez sur Fichier>Imprimer Rapport, puis sélectionnez ce qui 
doit être imprimé parmi les options disponibles et suivez les instructions à l’écran
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Reading and Comparing Values

 When a chart is displayed it is possible to follow the profile and obtain specific information along the 
length of the profile; this can be done by placing the cross-hair at the required point and clicking the left 
mouse button. Once this is done a horizontal and vertical line will appear, and the values indicated by the 
cross-hair are displayed in the top right-hand corner of the chart 

 Note that the cross-hair can be moved by pressing the left and right arrows on the keyboard 

Adjusting Profiles

There are 6 different buttons available to allow the user to adjust the way in which the profiles are displayed 
and mean that profiles that were taken on the same machines, but from different starting positions, can be
aligned. 

Move the profile left by one bar/segment 

Move the profile right by one bar/segment 

Return the profile to its original position 

Mirroring the profile 

When there are 2 or more profiles this aligns the profile to 
the highest bar/segment 

When there are 2 or more profiles this aligns the profile to 
the lowest bar/segment
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Zooming behaviour 

 Zooming is only possible in the Chart and Radial tabs. To zoom in on any part of a chart: 
1. Left-click a place on the left side of the chart section you wish to zoom. 
2. Hold down the mouse button while you drag a rectangle across and down to the right. 
3. Release the mouse button to perform the zoom. To zoom in horizontally: 
4. Proceed as above, but only move the mouse directly left or right to select the area to be enlarged. Two

vertical lines will be displayed across the chart to indicate the selection. 
Tozoominvertically:
1. Proceed as above, but only move the mouse directly up or down to select the area to be enlarged. Two 

horizontal lines will be displayed across the chart to indicate the selection. 
 To zoom out from any view:

1. Left-click any place in the chart and drag a rectangle across and up to the left to display a rectangle with
a cross in it. When you release the mouse button the chart will return to its original size and location. 

Alarms 

The PC-Software can check the commutator and slip ring recordings for the following alarm conditions. If the 

button is in colour  then it will indicate that an alarm has been triggered on the selected profile, if black 

and white then no alarms are triggered:

 TIR - Total Indicated Runout 
ñ  The difference between the highest and lowest points on the profile. 

MBTB - Maximum Bar-to-bar
ñ  The difference in height between adjacent commutator bars. 

MSTS - Maximum Segment to segment 
ñ  The difference in height between adjacent slip ring segments. 

High Mica
ñ  Lists anyMica insulation (between commutator bars) which are not recessed below the bar

surface. 

Downloading .Mas files

It is possible to download profiles taken on the previous version of the profiler that Morgan used to offer; this 
can be done by selecting ì File>Importing MAS FileÖ î  and following the on-screen instructions. 

Lire et comparer les valeurs

• �Quand un tableau est affiché, il est possible de suivre le profil et d’obtenir des informations spécifiques 
en rapport avec la longueur du profil ; il suffit de placer le curseur sur le point requis et de cliquer avec le 
bouton gauche de la souris. Dès que c’est fait, une ligne horizontale et une ligne verticale apparaissent et 
les valeurs indiquées par le curseur s’affichent dans le coin supérieur droit du tableau

• Remarquez que l’on peut déplacer le curseur en se servant des flèches gauche et droite du clavier

Réglage des profils

L’utilisateur dispose de six boutons différents pour ajuster la façon dont les profils sont affichés, cela 
signifie donc que les profils qui ont été saisis sur les mêmes machines, mais à partir de positions de départ 
différentes, peuvent être alignés..

Déplacer le profil à gauche d’une lame/segment  

Déplacer le profil à droite d’une lame/segment 

Ramener le profil à sa position d’origine

Refléter le profil

S’il y a deux profils ou plus, le profil est ajusté sur la lame/le segment le plus haut

S’il y a deux profils ou plus, le profil est ajusté sur la lame/le segment le plus bas
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Zooming behaviour 

 Zooming is only possible in the Chart and Radial tabs. To zoom in on any part of a chart: 
1. Left-click a place on the left side of the chart section you wish to zoom. 
2. Hold down the mouse button while you drag a rectangle across and down to the right. 
3. Release the mouse button to perform the zoom. To zoom in horizontally: 
4. Proceed as above, but only move the mouse directly left or right to select the area to be enlarged. Two

vertical lines will be displayed across the chart to indicate the selection. 
Tozoominvertically:
1. Proceed as above, but only move the mouse directly up or down to select the area to be enlarged. Two 

horizontal lines will be displayed across the chart to indicate the selection. 
 To zoom out from any view:

1. Left-click any place in the chart and drag a rectangle across and up to the left to display a rectangle with
a cross in it. When you release the mouse button the chart will return to its original size and location. 

Alarms 

The PC-Software can check the commutator and slip ring recordings for the following alarm conditions. If the 

button is in colour  then it will indicate that an alarm has been triggered on the selected profile, if black 

and white then no alarms are triggered:

 TIR - Total Indicated Runout 
ñ  The difference between the highest and lowest points on the profile. 

MBTB - Maximum Bar-to-bar
ñ  The difference in height between adjacent commutator bars. 

MSTS - Maximum Segment to segment 
ñ  The difference in height between adjacent slip ring segments. 

High Mica
ñ  Lists anyMica insulation (between commutator bars) which are not recessed below the bar

surface. 

Downloading .Mas files

It is possible to download profiles taken on the previous version of the profiler that Morgan used to offer; this 
can be done by selecting ì File>Importing MAS FileÖ î  and following the on-screen instructions. 

Comportement du zoom

• Zoomer n’est possible que sous les onglets Tableau et Radial. Pour zoomer sur une partie du tableau :
1. Cliquez gauche à un endroit sur le côté gauche de la section du tableau que vous souhaitez agrandir.
2. Maintenez enfoncé le bouton de la souris tout en étirant un rectangle vers la droite.
3. Relâchez le bouton de la souris pour zoomer. Pour zoomer horizontalement :
4. �Procédez comme ci-dessus, mais déplacez seulement la souris directement à gauche ou à droite, 

pour sélectionner la zone à élargir. Deux lignes verticales seront affichées à travers le tableau pour 
indiquer la sélection.

• Pour zoomer verticalement :
1. �Procédez comme ci-dessus, mais déplacez seulement la souris directement en haut ou en bas pour 

sélectionner la zone à élargir. Deux lignes horizontales seront affichées à travers le tableau pour 
indiquer la sélection.

• Pour effectuer un zoom arrière :
1. Cliquez à gauche quelque part dans le tableau et étirez un rectangle vers la gauche pour afficher un 
rectangle avec une croix à l’intérieur. Quand vous libérez la souris, le tableau revient à sa taille et à son 
emplacement d’origine.

Alarmes

Le logiciel PC peut contrôler les enregistrements du collecteur et de la bague collectrice pour les états 

d’alarmes suivants. Si le bouton a une couleur,  cela indique que l’alarme a été déclenchée pour le 

profil sélectionné, s’il est noir et blanc,  alors aucune alarme n’a été déclenchée :

• TIR - Faux-rond total (Total Indicated Runout)
– La différence entre le point le plus haut et le point le plus bas sur le profil.

• MBTB - Maximum barre à barre (Maximum Bar-to-bar)
– La différence de hauteur entre les barres adjacentes du collecteur.

• MSTS - Maximum de segment à segment (Maximum Segment to segment)
– La différence de hauteur entre les segments de bague collectrice adjacents.

•        Mica important
– �Liste les isolations de mica (entre les barres de collecteur) qui ne sont pas encastrées 

sous la surface des barres.

Téléchargement de fichiers .Mas
Il est possible de télécharger des profils saisis avec la précédente version du profileur proposée 
auparavant par Morgan ; il suffit de sélectionner « Fichier>Importer Fichier MAS… » et de suivre les 
instructions à l’écran.
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APPENDIX A: SPECIFICATIONS

These specifications may be changed in future versions: 
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APPENDIX B: WARRANTY & REPAIRS

Warranty 
The warranty covers construction and material faults of the MSPro14 equipment and the warranty period is 
valid for 1 year after invoicing.  

Damage due to incorrect or inexpert handling is excluded from the warranty. Do not open the housing of the 
MSPro14 unit yourself as this will invalidate the warranty.

Repairs & Calibration 
Repairs can and will be done by (or under the authority of) the developer/manufacturer; this can also be 
done elsewhere but this is at the Users own risk.

In the unlikely event that repairs are necessary please contact your local Morgan sales office. They can 
inform you on how to proceed. You can contact them as well if you want to have your MSPro14 calibrated. 

Ces spécifications sont susceptibles de changer avec les futures versions :

ANNEXE A: SPECIFICATIONS



51

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 51

APPENDIX A: SPECIFICATIONS

These specifications may be changed in future versions: 

52

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 52

APPENDIX B: WARRANTY & REPAIRS

Warranty 
The warranty covers construction and material faults of the MSPro14 equipment and the warranty period is 
valid for 1 year after invoicing.  

Damage due to incorrect or inexpert handling is excluded from the warranty. Do not open the housing of the 
MSPro14 unit yourself as this will invalidate the warranty.

Repairs & Calibration 
Repairs can and will be done by (or under the authority of) the developer/manufacturer; this can also be 
done elsewhere but this is at the Users own risk.

In the unlikely event that repairs are necessary please contact your local Morgan sales office. They can 
inform you on how to proceed. You can contact them as well if you want to have your MSPro14 calibrated. 

ANNEXE B : GARANTIE ET RÉPARATIONS

Garantie

La garantie couvre les défauts de construction et de matériaux de l’équipement MSPro14, elle est valide 
pour une durée d’un an à partir de la date de la facture.

Les dommages, du fait d’un maniement incorrect ou inadéquat, sont exclus de la garantie. N’ouvrez pas 
l’unité MSPro14 vous-même, cela annulerait la garantie.

Réparation et calibrage

Les réparations peuvent être, et seront, effectuées par le (ou sous l’autorité du) fabricant/concepteur ; elles 
peuvent aussi être effectuées ailleurs, mais aux risques et périls de l’utilisateur.

Dans le cas improbable où des réparations seraient nécessaires, veuillez contacter votre bureau de vente 
local Morgan. On vous y informera de la procédure à suivre. Vous pouvez également les contacter si vous 
souhaitez calibrer votre MSPro14.
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